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Agenda

» Welcome/Introductions
» Project Background/Purpose

» Review and Application of Systemic Safety
Process

» Discussion/Feedback on Process

» Closeout
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Project Team

» ODOT
» NCHRP Staff and Panel

» Consultant Team

» Kittelson & Associates, Inc.
» DKS
» Chris Monsere, PhD, PE
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Project Background and Purpose
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Project Background

» Last Pedestrian and Bicycle Safety Plan Completed
2014

» NCHRP Funding and Interests
» Application of NCHRP Research Report 893 —

€ KITTELSON
™! & ASSOCIATES

- ODOT'’s current plan was completed in 2014
- Since then:
- ODOT'’s data has improved
- Recommended systemic analysis methods have been published in NCHRP
Research Report 893
- ODOT applied for and was awarded NCHRP implementation funds to apply the
results of NCHRP Research Report 893 to update the 2014 plan.



Project Objectives

» This Plan Provides:

» Framework for Conducting Systemic Pedestrian and
Bicycle Safety Analyses

» Risk Factors to Identify Locations for Treatments
» Example Applications and Treatment Options

» This Plan Does Not Provide:
» A Project List
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- This slide shows the project objectives
- The emphasis is that this project is not a typical plan with resulting in projects, but
rather it provides a framework for how to conduct analyses, what risk factors

ODOT Regions and local agencies can use to identify locations for treatments, and
provides example applications



Pedestrian and Bicycle Systemic
Safety Process
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Crash Locations Seem Random

2015 Bicycle Crashes

e

- This slide shows Fatal and Injury A bike crashes in the Portland Metro area from
2015



Crash Locations Seem Random

2016 Bicycle Crashes

- This slide shows Fatal and Injury A bike crashes in the Portland Metro area from
2016
- Note how the locations have shifted since 2015



Crash Locations Seem Random

2017 Bicycle Crashes

- This slide shows Fatal and Injury A bike crashes in the Portland Metro area from
2017
- Note how the locations have shifted since 2015 and 2016
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Crash Locations Seem Random

2015 Pedestrian Crashes ®  Fatal Injry (K)

©  Suspected Serious Injury (A)
Urban Arese

This slide shows Fatal and Injury A pedestrian crashes in the Salem area from 2015
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Crash Locations Seem Random

2016 Pedestrian Crashes STkl 00
©  Suspected Serous injury (A}
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- This slide shows Fatal and Injury A pedestrian crashes in the Salem area from 2016
- Note how the locations have shifted since 2015
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Crash Locations Seem Random

2017 Pedesfrian Crashes ®  Fatalinjry ()

Urban Areas.

- This slide shows Fatal and Injury A pedestrian crashes in the Salem area from 2017
- Note how the locations have shifted since 2015 and 2016
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Systemic Safety — A Proactive Approach

» Prevent Crashes Before They Occur
» Crash Probability, Not History

» Crash Locations Spread Across a Network
» Severe Crashes

» Ped/Bike Crashes

» Locations are Random, but Contributing Factors
Are Predictable
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- This slide describes what the systemic safety approach is
- The key takeaway is emphasized in italicized text. These crash types are spread
around the network, so it appears that the locations are random but the factors

that contribute to these factors are predictable so these crashes can be effectively
prevented
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Overall Process

Step 1: Define Study
Scope

Step 7: Evaluate
Program and Project Step 2: Compile Data
Impacts

Step é: Refine and
Implement the
Treatment Plan

\ Y 4

Step 5: Select Step 4: Identify
Potential Potential Treatment

Countermeasures . Sites
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Step 3: Determine Risk
Factors

- This slide presents the 7-step process from NCHRP Research Report 893.

- Itis aniterative process

- We will discuss each of the seven steps in more detail in the coming slides
- This project focused on steps 1-5



Most
Reactive

Systemic Safety Benefits

» Comprehensive Decision-making Basis

» Cost-effective

» Typically Low-cost Treatments at Similar Sites
» Data-driven

» Proactive

» Consistency

PR I G
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Graphic source:
NCHRP Research
Report 893

-This slide presents the benefits of a systemic approach
-Comprehensive decision making — accounts for factors that a hot-spot type of
approach does not, including randomness

-It’s important to note that since it’s a data-driven process, it is approved for use in

the HSIP project selection process
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Step 1 — Define Study Scope

» Study Area

» Jurisdiction, sub-area, etc.
» Target Facility/Location Types

» Intersections, segments, functional class, etc.
» Target Crash Types

» Pedestrian, bicycle, roadway departure, etc.
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This slide presents the elements that go into Step 1 in the NCHRP Research Report
893 process

A crash tree or other analysis can help determine how the study scope should be
focused
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Step 1 — Define Study Scope — Oregon
Pedestrian Crash Tree

8,877 woreson aoor-2om)

92.71% 1.3%

I N | I ! |
Intersection  Driveway Segment Intersection  Driveway  Segment

62.9% 8% 200%  253%  6.8%  61.9%
K 3.3% 2.2% ) 1.0% 6.7% 8.8% 22.9%
A 10.4% 8.2% 18.5% 121% 231% 16.8%
B 46.2% 43.1% 44.6% 53.5% 40.6% 40.9%
C 39.5% 45.6% 25.4% 21.7% 21.5% 19.0%
0 0.6% 0.9% 0.5% 0.0% 0.0% 0.4%
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- This slide presents the crash tree completed for pedestrian crashes
- Most pedestrian crashes occur in urban areas
- And within urban areas, at intersections
- Crashes are more prevalent in-between intersections in rural areas
- Crashes in rural areas and along segments tend to be more severe than at
intersections or driveways
- Many of the segment crashes are mid-block crossing crashes
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Step 1 — Define Study Scope — Oregon
Bicycle Crash Tree

BICYCLE CRASHES
9 | 6 52 IN OREGON (2007-2017)
9,166 486
95% 5%
[ \ \ |
Intersection Driveway Segment Intersection Driveway Segment

6,264 1,842 1,060 213 5 198
68% 20% 12% 44% 15% 41%

0.5% 0.3% 23% 4.0% 47% 11.1%
6.5% 54% 9.8% 10.3% 25% 18.9%
56.5% 56.3% 59.6% 60.4% 63.4% 50.5%
33.8% 35.2% 26.3% B.9% 29.4% 18.6%
2T% 2.8% 2.0% 14% 0% 0.9%
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- This slide presents the crash tree completed for bicycle crashes
- Most bicycle crashes occur in urban areas
- And within urban areas, at intersections
- Crashes are more evenly split between segments and intersections in rural areas
- Crashes in rural areas and along segments tend to be more severe than at
intersections or driveways
- Difference from peds — more crashes at driveways and fewer at segments —
generally, fewer midblock crossing crashes.



Step 1 — Define Study Scope — ODOT Plan

» Study Area — Statewide

» Target Facility/Location Types — State Highways
» Emphasis on Urban Areas (population >5,000)

» Target Crash Types

» Pedestrian

» Bicycle
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- This slide presents how the study scope was defined for the ODOT plan

Urban areas are emphasized, but rural areas are still considered so as to show a
variety of applications
Bicycle and pedestrian crashes are analyzed separately
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Step 2 — Compile Data

» GIS/Linear Referenced Format
» Roadway
» Functional Class, Speed, Signals, Sidewalks, etc.
» Land-use/Demographic Data
» Zoning, Parks, Schools, Mode Split, Transit Stops, etc.
» Crash
» Exposure (Count)
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This slide presents the elements that go into Step 2 in the NCHRP Research Report
893 process
Ideally, all data is available in GIS or other linear referenced format
There are four categories of data
- Roadway
- Land-use/demographic
- Crash
- Exposure/Count
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Step 2 — Compile Data — ODOT Plan

XX X X X X X X X X X X X X X X X X
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This slide presents the data compiled for the ODOT plan
ODOT'’s dataset was the most complete
The datasets from the larger three metro areas were used to augment the analysis
for some factors
- These three metro areas were selected since they had count programs and
relatively complete infrastructure datasets
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Step 3 — Determine Risk Factors

» Possible Approaches

» Crash Prediction Models/Safety Performance
Functions

» Research/Local Judgment

» Crash Frequency-Based
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This slide presents three possible approaches to Step 3 in the NCHRP Research
Report 893 process

Crash prediction models/safety performance functions are ideal, but they are data
intensive and many jurisdictions may not have the necessary data to develop them
Research/Local Judgment is simple and could be particularly good for smaller
jurisdictions

Crash Frequency is intuitive and can provide some local data backing for choosing
risk factors, but it has its holes, too, especially if working with a smaller dataset.
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Step 3 — Determine Risk Factors — ODOT
Plan Approach

» Possible Approaches

» Crash Prediction Models/Safety Performance
Functions

» Research/Local Judgment

»Crash Frequency-Based
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This slide presents the chosen approach for the ODOT plan
It is primarily crash frequency-based, but it’s also augmented with research on
factors for which the data was not available or the analysis was inconclusive
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Step 3 — Determine Risk Factors — Analysis
Example — Functional Classification
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- This slide presents an example of how functional classification was analyzed with
respect to bicycle crashes
- Notably, about 62% of all bicycle crashes occur on Urban Principal and Minor

Arterials, which collectively make up about 8% of Oregon roadways based on
mileage
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Step 3 — Determine Risk Factors — ODOT

Plan Results - Pedestrian
[ Rekfactor | Focliyee | uban | Rual |

General

Segment X
Segment

Segment

X X X X X

X

Segment
Context

General X

X
X X
X X

General

General
General
Demographics
General X X
Other Risk Factors (Not Used in Screening Due to Data Availability)

Intersection X X

Intersection X

Intersection X X
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- This slide presents the identified risk factors for pedestrian crashes

- Data and research backs these up — used a combination to determine which to
select.

- There are different urban and rural factors

- These can be used for screening or site analysis

- There is overlap across certain variables
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Step 3 — Determine Risk Factors — ODOT

Plan Results - Bicycle

[ Riskfactor | Faclitylype | Umban | Rural |
Roadway Characteristics

General

General

Segment
Segment

Segment

X X X X X X
=<

X

Segment
Context
General

X
X X
X X

General

General
Demographics

General X X
Other Risk Factors (Not Used in Screening Due to Data Availability)
Intersection X

Intersection

Intersection
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X X X X X
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- This slide presents the identified risk factors for bicycle crashes

- Data and research backs these up — used a combination to determine which to
select.

- There are different urban and rural factors

- These can be used for screening or site analysis

- There is overlap across certain variables
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Step 4 — Identify Potential Treatment Sites

» Evaluate Network for Locations with Risk Factors
» Basic Count
» Weighted
» All Sites w/ a Certain Factor
» Select Sites
» Budget, Countermeasure Applicability
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This slide presents what goes into Step 4 of the NCHRP Research Report 893
process
There are three ways to evaluate the network according to the risk factors
- Basic count = 1 point per risk factor
- Weighted = Different points are assigned for the presence of different risk
factors based on some type of weighting
- All sites with a certain factor = This is typically chosen if there is a
countermeasure an agency wants to deploy that is valid for a certain type
of factor (e.g., installing pedestrian logic at flashing yellow arrow
installation sites)
There are a number of factors that can go into selecting white sites to move
forward with, including an agency’s budget and whether there are pre-selected
countermeasures and if they apply to a site
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Step 4 — Identify Potential Treatment Sites —
ODOT Plan Approach

» GIS-based Screening
» Weighted Risk Factors

» Manual Corridor Review
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This slide presents ODOT'’s approach to Step 4

Risk factors were weighted based on their correlation with crash severity

After the initial analysis was completed, the project team manually reviewed the
segments to create corridors with logical start/end points
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Step 4 — Identify Potential Treatment Sites —
Bicycle o,
Results

Urban Areas
ODOT Regions
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- This slide presents the results of the bicycle screening.
- Sites were generally selected from the two highest scoring quintiles
- The same process was completed for pedestrian sites
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Step 4 — Identify Potential Treatment Sites —

Selected Sites for Analysis

Example
Bicycle | e O e
S ite s = Selecied Sites

Urban Areas

Herhiston

LoGlinde

ODOT Regions

nnnnnnn

nnnnnnn
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This slide presents the 25 sites selected for example applications for bicycles
These are sites for examples and they were picked to be representative of a range
of conditions. They are not selected for projects, necessarily.

The same process was completed for pedestrian sites
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Step 5 — Select Potential Countermeasures

» Establish a Selection Framework

» Effectiveness

» Program/Crash Type Relationship

» Cost

» Feasibility
» Develop Potential Countermeasure List
» Select Countermeasures
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- This slide presents what goes into Step 5 of the NCHRP Research Report 893
process
- This project focuses on the first two steps
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Step 5 — Select Potential Countermeasures —
ODOT Plan Process

» Review Existing Site Conditions
» Physical/geometric Conditions
» Risk Factor Presence
» Traffic Data
» Land-use Context
» Crash History
» Identify Initial Countermeasure List

» Assess Feasibility of Initial List
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This slide presents the process followed for Step 5 for the ODOT plan

The resulting countermeasures list for each site is wide ranging. Each site would
need to be investigated further to determine which countermeasures are the most
cost effective and feasible
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13: Willamette Highway (ORS58), Thaicher Lane fo Hills Street - Oakridge
Context: Rural ODOT Region: 2 Length: 1.98 miles

Project Location

ste p 5 = Se I eCt Pote ntia I From Street: Thatcher Lane (MP: 34.19) To Street: Hill Street (MP: 35.85)
Countermeasures —

Example Sites — OR 58
(Oakridge)
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- This slide presents the first page of each site. It shows:
- Context
- Location
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13: Willamette Highway (OR58), Thatcher Lane to Hills Street — Oakridge

Step 5 — Select Potential
Countermeasures —
Example Sites — OR 58 |
(Oakridge)

8 Injury Crash

Crash Histery (2007 - 2017)

5 Total Crashes (Bicyclist Involved)

WA njury Crash

WFatal
Intersection (Signalized)
0 1 2 3 4
Risk Factors Present:
» Principal Arterial = ALL »  Proximity fo Schoals (1 Mile] - MOST Risk Score
(Rank): 4.455

» Posted Speed (>=30 mph] = ALL | » Proximity to Transit Stops (1/4 Mile) - MOST

(Second 20%)
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- This slide shows how crash data is shown for each site, including:
- Crash history, if there is any
- Therisk factors that are present
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Countermeasure: Install Buffered Bike Lane ARTS #: BP20  CRF: 36

Potential Segment Locations:

» Segments of ORS8 lacking bicycle facilies (all)]

.

Ste 5 — Se I ect Pote nt I a I Note: Only one of BP18 or BP20 are recommended fo be installed at a given location
Note: A roadway reorganization would be required fo fit on-street bicycle facilities

Potential Affected Risk Factor and/or Conflict: Cycling in road or on shoulder crashes

Co u nte r m e a S u re S i’ Planning Level Countermeasure Cost: $247,000 per 1,000 feet (cne side)

Countermeasure: Install Urban Green Bike Lanes at Conflict Points ARTS #: BP5 CRF: 39

Example Sites — OR 58

» Driveway aceess points along ORS58 with high-volume driveways

i
(Oakridge) ot ot o copite oot i 71520

Potential Affected Risk Factor and/or Cenflict: Cycling in road or on shoulder crashes

Planning Level Countermeasure Cost: $10,000 per 100 feet (one side)

c Access Manag 1t (>48 per Mile to 26-48 per
Mile)

ARTS #: H30 CRF: 29

Potential Segment Locations:

> Segments of ORS8 with high levels of commercial access (maijority of comidor)

Potential Affected Risk Facter and/er Conflict: Vehicle vs. bicycle crashes at driveways

Planning Level Countermeasure Cost: Case by case basis’

Countermeasure: Convert 4-Lane Roadway to 3-Lane Roadway . )

with Center Turn Lane (Road Diet) ARTS #:BP16 | CRF: 29
Potential Segment Locations:

» Segments of OR58 with 4-lanes [consider reducing 5-lane sections to 3-lane as well)

Note: Countermeasure to would allow for installation of on-street bicycle facilities: BP18 or BP20

Potential Affected Risk Facter and/er Conflict: Cycling in road or on shoulder crashes

I KITTELSON Planning Level Countermeasure Cost: $193.000 per 1.000 feet
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1. Cost specific 1o context and number of Gccess points.

- This slide shows an example of how countermeasures are presented.
- For each countermeasure, the following information is presented:

- Its crash reduction factor (CRF)

- Its ARTS #

- Where it might be applicable

- What crash types/risk factors it addresses

- Implementation considerations

- Planning-level cost estimates



Step 6 — Refine & Implement Treatment
Plan

» Consider Additional Community Priorities
» Planned Projects, Additional Data, Diversity, etc.
» Perform Additional Diagnostics

» Field Visit, Other User Effects, etc.

» Perform Economic Assessments
» ARTS — Cost-Effectiveness Index

» Allocate Funding and Implement Projects
» ARTS has Pedestrian/Bicycle Systemic Funding

€ KITTELSON
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- This slide presents what goes into Step 6 of the NCHRP Research Report 893
process
- This step was not completed for this project
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Step 6 — Refine & Implement Treatment
Plan — ODOT Approach

» Roll out Plan
» Regions — ARTS Subcommittee
» Pedestrian and Bicycle Program Liaisons
» Work with ARTS Consultant to Inform Local
Agency projects
» Publish Plan on ODOT Websites
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This slide presents how ODOT plans to implement the plan
Note that two webinars have already been conducted with ODOT and local agency
staff
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Step 7 — Evaluating Program and Project
Impacts

» Program Implementation Measures
» Is Process Being Carried Out
» Funding Allocated to Projects

» Implementation Barriers/Lessons Learned
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This slide presents what goes into Step 7 of the NCHRP Research Report 893
process

This step was not completed for this project

The first set of measures evaluate whether/how the program is being
implemented
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Step 7 — Evaluating Program and Project
Impacts (cont.)

» Program Outcome Measures
» # of Pedestrian/Bicycle Fatalities and/or Serious Injuries and
F/SI Crashes
» Functional Class
» Segments vs. Intersections
» Posted Speed
» Population 65 Years+
» Roadway Ownership
» Urban vs. Rural

» Refine Program Based on Results
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This slide presents what goes into Step 7 of the NCHRP Research Report 893
process
This step was not completed for this project
The second set of measures evaluate the program’s outcome
The performance measures shown here are those selected by ODOT
- They will be evaluated separately for pedestrian and bicycle crashes
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Discussion
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